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1 Understanding your CADfix purchase 
Your CADfix license will be one of the following types: 

• Evaluation 

• Single node-locked 

• Network (floating), or multiple node-locked 

Other installation configurations are available, and CADfix support can provide more advice if needed. 

 

Within this document, each of these license types is colour-coded (as above) to help with the identification 

of the relevant information. 

 

 

 

Evaluation 

This installation uses a local license file that is time-limited. It does not require any licensing services, so 

only CADfix needs to be installed. Evaluation licenses do not normally allow remote access, but this 

license can be installed on multiple computers. 

 

 

Single node-locked 

A node-locked installation is locked to a specific computer, which is identified by its host ID (MAC 

address). Both the CADfix application and the license services are usually installed on the same computer. 

 

Where a purchase includes multiple node-locked seats, the installation can follow the ‘Network (floating), 

or multiple node-locked’ procedure.  This allows all the CADfix installations to share a single license 

server. 

 

 

Network (floating), or multiple node-locked 

A floating CADfix license will run only on a specifically defined range of computers. The allowable range 

should be discussed with the CADfix sales team before the purchase, and will be categorised as LAN, 

WAN, RWAN, or WWAN depending on the locations of required users. Each allowable computer within 

this range will be identified using one of the following options (or a combination): 

 

IP address range: 126.10.10.* 

IP address list: 126.10.10.5  126.10.10.6  126.10.10.7 

MAC address list: 48ad3f56ffcb a93b2f2dd9ab  e8ff3ba826c0 
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2 Quick installation guide 
 

 

2.1 Evaluation 

Preparation 

a)  Request an ‘Evaluation’ license file. 

Usually supplied via your CADfix sales representative by email.  

or: 

Americas customers - email works_supp@iti-global.com  

Non-Americas customers - email eukeys@iti-global.com  

b)  Download CADfix 

The latest download link is supplied in the license file email that was sent to you - Download the ‘Installer’ 

package. 

A ‘Zip file’ installation is also available for download (not covered in this installation document). 

Installing CADfix and the license  

c)  Install CADfix 

Run the downloaded installer program – See Installing CADfix 

d)  Copy your license file into “..\CADfix PPS 6\lic” 

When received from ITI, copy the license file into the CADfix lic folder.  

e.g. “C:\Program Files\CADfix PPS 6\lic\” – See Installing the license service 

e)  Run CADfix 

Double-click on the desktop icon, or run the “startCADfix.bat” script in the CADfix installation folder  

e.g.”C:\ Program Files\CADfix PPS 6\ startCADfix.bat” 

 

 

  

mailto:works_supp@iti-global.com
mailto:eukeys@iti-global.com
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2.2 Single node-locked 

Preparation 

a)  Request a license file. 

Usually supplied via your CADfix sales representative by email.  

or: 

Americas customers - email works_supp@iti-global.com  

Non-Americas customers - email eukeys@iti-global.com  

To create the license file, the ITI support team will need to know: 

• The CADfix workstation MAC address 

b)  Download CADfix 

The latest download link is supplied in the license file email that was sent to you - Download the ‘Installer’ 

package. 

A ‘Zip file’ installation is also available for download (not covered in this installation document). 

Installing CADfix and the license server. 

c)  Install CADfix 

Run the downloaded installer program – See Installing CADfix 

d)  Copy your license file into “..\CADfix PPS 6\lic” 

When received from ITI, copy the license file into the CADfix lic folder.  

e.g. “C:\Program Files\CADfix PPS 6\lic\” – See Installing the license service 

e) Install FlexNet services 

For detailed instructions about installing the FlexNet services, see Configuring the license manager. 

f)  Run CADfix 

Double-click on the desktop icon, or run the “startCADfix.bat” script in the CADfix installation folder  

e.g.”C:\ Program Files\CADfix PPS 6\ startCADfix.bat” 

 

  

mailto:works_supp@iti-global.com
mailto:eukeys@iti-global.com
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2.3 Network (floating), or multiple node-locked 

Preparation 

a)  Request a license file. 

Usually supplied via your CADfix sales representative by email.  

or: 

Americas customers - email works_supp@iti-global.com  

Non-Americas customers - email eukeys@iti-global.com  

 

To create the license file, the ITI support team will need to know: 

• CADfix license server network name or IP address 

• CADfix license server MAC address 

• CADfix workstation IP address list/range, or MAC address list. 

(If a ‘multiple node-locked installation’, then this must be a MAC addresses list). 

b)  Download CADfix 

The latest download link is supplied in the license file email that was sent to you - Download the ‘Installer’ 

package. 

A ‘Zip file’ installation is also available for download (not covered in this installation document). 

Installing CADfix and the license server. 

c)  Download and install the CADfix license server software onto the license server or copy a lic folder from 

an existing CADfix client installation.  - Download the license server only from www.cadfix.eu/13LIC/  

d)  Copy your license file into “..\CADfix PPS 6\lic” 

When received from ITI, copy the license file into the CADfix lic folder.  

e.g. “C:\Program Files\CADfix PPS 6\lic\” – See Installing the license service 

e) Install FlexNet services  

For detailed instructions about installing the FlexNet services, see Configuring the license manager 

Install CADfix on client workstations 

f)  Install CADfix 

Run the downloaded installer program – See Installing CADfix 

g) Link CADfix to the license server – See Linking CADfix to the license 

h)  Run CADfix 

Double-click on the desktop icon, or run the “startCADfix.bat” script in the CADfix installation folder  

e.g.”C:\ Program Files\CADfix PPS 6\ startCADfix.bat” 

 

  

mailto:works_supp@iti-global.com
mailto:eukeys@iti-global.com
http://www.cadfix.eu/13LIC/
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3 Detailed installation procedures 

3.1 Installing CADfix 

 

1) Double-click on the downloaded installer package to start the installation process. 

e.g. CADfixPPS6_WINNTx64.msi 

 

 

2) A Welcome screen is displayed: 

 
a) ‘Next’ starts the installation process. 

b) ‘Cancel’ will stop the installation process. 

 

 

3) The CADfix license agreement is displayed. This allows you to review and print the agreement before 

installing CADfix. 

 
a) To continue, select ‘I accept the terms of the license agreement’, and press the ‘Next’ button. 

b) ‘Back’ will return to the Welcome screen. 

c) ‘Cancel’ will stop the installation process. 
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4) The ‘Destination Folder’ screen shows the default installation location: 

(This location may vary depending on the version you are installing.)  

 
a) ‘Change…’ allows the selection of a different location for the CADfix installation. 

b) ‘Next’ continues the installation. 

c) ‘Back’ returns to the ‘License agreement’ screen. 

d) ‘Cancel’ will stop the installation process. 

 

 

 

5) The ‘Choose Language’ screen allows English or German to be selected as the CADfix display 

language.  - This selection only applies to the CADfix interface and does not affect these installation screens. 

 
a) ‘Next’ configures CADfix to use the selected language and continues the installation. 

b) ‘Back’ returns to the ‘Destination Folder’ screen. 

c) ‘Cancel’ will stop the installation process. 
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2) The ‘Ready to Install the Program’ screen allows a last chance to change installation options before 

writing files to disk: 

 
a) ‘Install’ starts the installation of CADfix using these settings. 

b) ‘Back’ returns to the ‘Choose Language’ screen. 

c) ‘Cancel’ will stop the installation process. 

 

 

 

 

3) Windows may ask permission to allow these changes to be made to your computer. This may initially 

show as a shield on the taskbar .  

 
a) Select ‘Yes’ to allow the CADfix installer to copy the required files. 

b) Select ‘No’ to return to the ‘Ready to Install the Program’ screen. 

 

CADfixPPS6_WINNTx64 
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4) During the installation of the files, a progress bar is displayed: 

 
Pressing cancel during this stage will cancel the installation process. 

 

 

 

5) When complete, a message is displayed informing you of this. 

 
a) Press ‘Finish’ to close this screen 

 

 

• A ‘CADfix PPS 6’ start-up icon should now be displayed on your desktop and in your Windows Start 

menu: 

  

Note: Do not attempt to pin the CADfix to the Windows Task Bar. This will cause a startup error. 
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3.2 Installing the license service 

CADfix utilises FlexNet license services for its licensing. Whether it is required and where it is installed will 

depend on the configuration of your CADfix purchase. Please discuss this with CADfix support if you have 

any doubts or want further advice. 

 

 

 

 

Evaluation license 

The license server is not needed for an evaluation license.  To run an evaluation license: 

1. Ensure the supplied license file is named ‘cadfix.dat’. 

2. Copy cadfix.dat to the CADfix lic folder. 

e.g. “C:\Program Files\CADfix PPS 6\lic\” 

 

 

 

 

 

Single node-locked 

When a license manager is required on the same computer as the CADfix application, the license 

manager can be run from within the CADfix installation. Alternatively, the license manager can be installed 

in a non-version-specific location to avoid reconfiguration during subsequent upgrades (see ‘Network 

(floating), or multiple node-locked’ below). 

 

 

 

 

 

Network (floating), or multiple node-locked 

To install the license manager software as a server, there are three options available: 

• Install a full CADfix installation on the server. This will include the full FlexNet license server. 

• Download the license server installation package (www.cadfix.eu/14LIC/ ). 

The installation procedure is the same as the full CADfix installation and is therefore not repeated 

here. 

• Copy the lic folder from a CADfix installation onto the server at a static location where it can be run 

(e.g. “C:\Program Files\CADfix license\”). 

It is good to install the CADfix license in a non-version-specific location to avoid reconfiguration during 

subsequent upgrades of CADfix. 

 

  

http://www.cadfix.eu/14LIC/
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3.3 Configuring the license manager 

This configuration process, shown here, uses the FlexNet graphical user interface to configure Windows 

services. The process can also be completed at the command line, and this process can be requested 

from CADfix support. 

 

1. Using the file browser, open the CADfix license server installation folder. 

This folder contains: lmtools.exe, lmutil.exe, lmgrd.exe, and itiohio.exe 

 

 

2. Place a copy of the license file (cadfix.dat) into this installation folder. 

This is a text file containing: your license information, details of the license server, and information 

about which computers can run CADfix.  This may be supplied to you with a different name and will 

therefore need renaming to ‘cadfix.dat’. 

 

 

3. Right-click on lmtools.exe and select ‘Run as 

administrator’ to start the License Manager interface 

tool. 

 

 

 

4. If the User Account Control dialogue box appears, click ‘Yes’ 

to allow ‘LMTOOLS Utility’ to run. 

 

 

 

 

5. When LMTOOLS starts, open the ‘Service/License File’ tab, and select ‘Configuration using Services’: 
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6. Open the ‘Config Services’ tab and set the values: 

 ‘Service Name’ = “CADfix License” (Type this directly into the box) 

 ‘Path to lmgrd.exe file’ = Browse and select the lmgrd.exe file in the license installation folder. 

 ‘Path to license file’ = Browse and select the cadfix.dat file in the license installation folder.  

(You will need to change the file filter in the dialogue box from ‘*.lic’ to 

‘*.dat’ before you can see this file.) 

 ‘Path to the debug log file’ = Browse to the license installation folder and type in “cadfix.log” to create a 

new log file using this name. 

 ‘Use Services’ = ✓ 

 ‘Start Server at Power Up’ = ✓ 

 
7. Press ‘Save Services’ 

The Windows Services tool should now show the ‘CADfix License’ service as not started: 

 

 

8. Open the LMTOOLS ‘Start/Stop/Reread’ tab, select ‘CADfix License’, and press the ‘Start Server’ 

button. 
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• The message at the bottom of the ‘Start/Stop/Reread’ tab should now say the service has started: 

 
• The Windows Services tool should now show the ‘CADfix License’ service as running: 

 

If the license service will not start, then see License service not starting below. 

 

 

9. The LMTools utility program can now be exited (File → Exit). 

 

 

Note: If the ‘CADfix License’ service needs to be stopped/started/restarted, then this can be done via the 

LMTOOLS ‘Start/Stop/Reread’ tab, or via the Windows Services tool. Alternatively, this can be done using 

the Windows Services app – See CADfix license services.  

 

 

 

 

 

 

 

3.3.1 License service not starting 

If the license service will not start, then this may be due to local administration rights. To overcome this: 

 

1. Start the Windows Services tool and Right-click 

on the service 'CADfix license'. 

 

2. Select Properties. 

 

3. Change "log on as" from 'This account' to 'Local 

System account' 

 

4. Restart the license service. 

 

5. If the license service still does not start, then contact CADfix support for further help. 
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3.4 Recording License server information 

During the configuration of the CADfix License (section 3.3.6), a ‘Path to the debug log file’ was specified 

(e.g.“C:\Program Files\CADfix\lic\cadfix.log”).  This log file contains the license server’s configuration and 

license activities. 

Open the log file with a text editor, then find and record the following information: 

 FlexNet version number:  ....................................................................................  

 Server network name or IP address:  ....................................................................................  

 License file name and path:  ....................................................................................  

Lmgrd (license manager daemon) port number:  ....................................................................................  

 Itiohio (vendor daemon) port number:  ....................................................................................  

 Itiohio (vendor daemon) version number:  ....................................................................................  

 Method of linking to license server:  Local license  Short license  Environment variable 

 

The following is an extract from a cadfix.log file with this key information highlighted: 

  

FlexNet version number 

Server network name or IP address 

License file name and path 

Lmgrd (server) port number 

Vendor (itiohio) port number 

Itiohio version number 
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3.5 Ports and Firewall Settings 

Evaluation license 

The section does not apply to the installation of Evaluation licenses. 

 

Single node-locked 

Network (floating), or multiple node-locked 

CADfix requires inbound access to the license server via the two ports identified in the license log file – 

See Recording License server information. Failure to ensure both these ports are open to inbound IP 

traffic will cause a failure in the licensing and stop CADfix from starting. 

By default, the Windows firewall blocks inbound communications on any IP port and allows outbound 

communications on any IP port. Therefore, to ensure CADfix license communications work unimpeded:  

1) Check the CADfix license's log file to find the 'lmgrd' (server) and 'vendor’ (itiohio) port numbers in use. 

(See example license file extract below). 

  

 

2) The CADfix license server needs firewall exceptions added to allow inbound communications on the 

[lmgrd] and [vendor] ports.  

 

 

 

The example shown here allows  

inbound communications on TCP  

port numbers 32728 and 32729. 

 

 

 

3) The CADfix workstations should not need any 

exceptions unless the local security policy has 

changed port access.  

  

Lmgrd (server) port number 

 

Vendor (itiohio) port number 
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3.6 Linking CADfix to the license 

To allow CADfix to start, it needs to link to a valid license, and there are three options for this: 

When you have configured your installation, record which method you used on the form in section 3.5. 

 

Evaluation license 

Single node-locked 

3.6.1 Local license file 

Check that the license file has been copied into the client’s local “[CADfix installation]\lic” folder.  

(This should have already been done in section 3.2) 

 

 

Network (floating), or multiple node-locked 

3.6.2 Environmental variable 

An environmental variable can be set up for each user. This tells CADfix how to contact the server: 

CADFIX_KEY=[lmgrd port]@[server name] 

 e.g. 

CADFIX_KEY=32728@MYSRV01  

The actual values used in this variable can be found in the license server log file. 

 

 

3.6.3 Cut-down license file 

A ‘cut-down license file’ can be used as an alternate method of connecting CADfix to the license 

server. For further help with this, please get in touch with CADfix support. 

 

 

3.6.4 License connection errors 

If an error occurs when CADfix is trying to communicate with the license server, then a ‘FlexNet license 

finder’ error will be displayed. – Cancel this error. 

This will then be followed by a ‘Fatal error’ message, which will show the full error text – take a screenshot 

of this so you can share it with CADfix support. 

Following an installation, the biggest cause of license errors is that a firewall has blocked communications 

on ports that are being used by the license server. These port numbers are shown in the license log file 

(see Ports and Firewall Settings). 

1. The CADfix license server needs firewall exceptions to allow inbound communications on the 

‘lmgrd’ and ‘itiohio’ ports. 

2. CADfix client machine (running CADfix) should not need any exceptions to its firewall. 

For further support on licensing problems, please contact CADfix support. 
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4 Updating CADfix 
 

4.1 Updating your CADfix installation 

As part of the Maintenance, Enhancements, and Support (ME&S) package, you will be offered an upgrade 

for your CADfix. For most CADfix releases, the license manager will remain unchanged and will therefore 

not need upgrading. If the license manager does need upgrading, then this will be highlighted in the 

“What’s new…” release document.  

 

Service packs are supplied with their own installation instructions. 

 

 

Evaluation license 

If you are using an evaluation license of CADfix, then you will just need to uninstall your current CADfix 

installation and then install the newer version. – see Installing CADfix 

 

 

Single node-locked 

If you are using a node-locked license where the license server is part of the CADfix installation you are 

using, then: 

 

Recommended 

1) Pause the license service – See CADfix license services. 

2) (Optionally) uninstall your existing CADfix installation (this will also uninstall the license server files) 

3) Install the new version of CADfix – See Installing CADfix 

4) Configure the license services using this new installation – See Configuring the license manager 

 

Alternatively, follow the procedure for ‘Floating and Multi-seat node-locked licenses’ to reconfigure 

CADfix to get its license from the license server in the older installation. If the FlexNet licensing service 

has been updated in the new release, then this license server will also need updating - Contact CADfix 

support for more information. 

 

 

Network (floating), or multiple node-locked 

1) (Optionally) uninstall your existing CADfix installation. 

2) Install the new CADfix installation – See Installing CADfix 

3) Link CADfix to the license server if needed. If the variable ‘CADFIX_KEY’ has been used here, then 

this step is not needed – See Linking CADfix to the license 

4) If the license manager needs updating, then see Upgrading FlexNet license service files 
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4.2 Updating your CADfix license file 

Periodically, the license file you have been provided with will expire.  If this happens and you have not yet 

received an updated file, then contact your CADfix supplier. 

 

Evaluation license 

If you are using an evaluation licence, then: 

a) Make sure CADfix is not running. 

b) Copy the new license file into “CADfix PPS 6\lic”.  - Any existing license file can be overwritten. 

c) Restart CADfix, and it will automatically read this new license file. 

d) Once started, go to the pull-down menu ‘Help’ → ‘About CADfix’. This dialogue will show the 

modules that are licensed and the new license expiration date. 

 

Single node-locked 

If you are using a node-locked license and running through a license file that is part of your CADfix 

installation, then: 

a) Make sure CADfix is not running. 

b) Copy the new license file into “CADfix PPS 6\lic”.  - Any existing license file can be overwritten. 

c) Restart the FlexNet services – See CADfix license services. 

d) Restart CADfix, and it will automatically read this new license file. 

e) Once started, go to the pull-down menu ‘Help’ → ‘About CADfix’. This dialogue will show the 

modules that are licensed and the new license expiration date. 

 

Network (floating), or multiple node-locked 

If you are using a floating license as part of your CADfix installation, then: 

a) Make sure CADfix is not running. 

b) Copy the new license file into “CADfix PPS 6\lic”.  - Any existing license file can be overwritten. 

c) Restart the FlexNet services – See CADfix license services. 

d) If you have linked your CADfix installation to the license service using a full license file, then 

copy the new license file into the “CADfix PPS 6\lic” folder on the local CADfix client machine. 

e) Restart CADfix, and it will automatically read this new license file. 

f) Once started, go to the pull-down menu ‘Help’ → ‘About CADfix’. This dialogue will show the 

modules that are licensed and the new license expiration date. 
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4.3 CADfix license services 
1) Start the Windows Services App. 

 

2) Scroll down and select the “CADfix License” service. – Be aware that this service may have been 

named differently during the initial CADfix installation. 

 

 

3) The Action dropdown menu provides options to Start, Stop, Pause, Resume, and Restart the license 

service. Some of these options will be greyed out depending on the service’s current status. 

 

 

 

4.4 Upgrading FlexNet license service files 
1) Pause the license service – See CADfix license services. 

 

2) Copy new FlexNet license service files into the lic folder to replace the existing ones. 

The list of files includes: lmtools.exe, lmutil.exe, lmgrd.exe, and itiohio.exe 

 

3) Check you have the latest license file in the “CADfix PPS 6\lic” folder.  This should have an expiration 

date after today and be valid to operate with this version of CADfix. – Speak to CADfix support to 

verify this. 

 

4) Restart the license service – See CADfix license services. 
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4.5 Changing the display language 

The CADfix interface language is set during the installation by creating a System Environment Variable. 

e.g. 

CADFIX_LANGUAGE=English 

 

To change the display language, set the CADFIX_LANGUAGE variable to “English” or “German”. 

• If the CADFIX_LANGUAGE environment variable is deleted or is not set to a valid value, then 

CADfix will default to using English. 

• If CADFIX_LANGUAGE is also set up as a User Environment Variable, this value will override the 

System Environment Variable. 
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Appendix: Error messages 
Any code examples in the following explanations use example settings. Review your own settings to 

identify your specific values for these examples – See Recording License server information. 

1. CADfix errors 
Authorisation key file does not exist. 

 

CADfix cannot locate the license file.   

If using a license file, then copy the license file to the location shown in the error message:  

“[CADfix installation]\lic\cadfix.dat” – See Local license file 

Alternatively, set the CADfix_KEY environmental variable to point to the license files' location or the 

license service address. e.g. – See Environmental variable 

• The default location of the license for all CADfix versions (including evaluation licenses) is the lic 

folder in the CADfix installation directory. e.g. c:\Program Files\CADfix PPS 6\lic 

• The license file should be named cadfix.dat 

• If the CADfix_KEY environmental variable is used to locate a license server, then its values must 

match those in the license server log file. 

 

Can’t find a usable init.tcl in the following directories. 

 

This error usually occurs when CADfix has been pinned to the 

Windows taskbar - This action is not supported. 

The user should either start CADfix from the Windows Start 

menu or set up a desktop shortcut to the 

“..\CADfix\startCADfix.bat” file.  
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2. FlexNet errors 
 

If a licensing error occurs, the following error message will be displayed. 

 

 

 

 

To diagnose the problem, press the ‘Cancel’ button, and 

a further dialogue will be displayed containing the 

relevant error message. 

 

 

 

 

 

 

 

 

 

 

 

 

The start of the message starts with a description of the 

problem and the ‘FlexNet Licensing error’ on the 

bottom line. 

Record the ‘FlexNet Licensing error’, or take a 

screenshot to send to CADfix support. 

If available, you will also need a copy of the license log 

file. See Recording License server information 

 

 

 

 

 

  



 

 Public  

International TechneGroup Limited Page 24 of 29 Copyright © ITI 2026 

Cannot find license file (error:-1,xxx) 

 

 

CADfix cannot locate the license file or the details for connecting to the license server.  The locations 

where it is looking are shown in the error message. 

 

See error Authorisation key file does not exist.. 

 

 

 

 

Licenced number of users already reached (error:-4,xxx) 

 

 

There are too many CADfix sessions being run. Someone must close CADfix before another feature 

(named in the message) can be used. It may be that: a user has started CADfix and left it running, a batch 

script may be running CADfix, or a license has been locked out following a crash.  

The license should be freed automatically 15 minutes after a crash. 

 

Use the "lmutil lmstat” command to identify who is using CADfix, and arrange for one of the users to close 

CADfix: 

 cd C:\Program Files\CADfix\lic 

 lmutil lmstat -c 12345@server -A"  

 or  

 lmutil lmstat -c C:\CADfix\lic\cadfix.dat -A"  
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No such feature exists (error:-5,xxx) 

 

 

A license is found, but the feature you are trying to use does not exist in the license or cannot be used 

due to an encoding error. - Please contact CADfix support to verify your modules and check your license 

file. 

 

 

 

Invalid (inconsistent) license key (error:-8,xxx) 

• Error using local license file: 

 
• Error when using a license server: 

 

 

An inconsistency has been detected with the license encryption. Please get the license file checked by 

CADfix support. 

 

With a license server, this is also caused when the vendor daemon (itiohio) is not reachable. This may be 

because the vendor daemon’s port is blocked. Ensure the port is available and is explicitly opened as an 

exception in the server’s firewall (see Ports and Firewall Settings). 

 

 

  



 

 Public  

International TechneGroup Limited Page 26 of 29 Copyright © ITI 2026 

Invalid host (error:-9,xxx) 

 

 

The workstation attempting to run CADfix does not match the allowed list of clients in the license file. 

Either the computer's IP address is not in the license, or the MAC address does not explicitly match. If you 

are running CADfix from a remote computer, then this may change the credentials being used. 

 

Either: move CADfix onto a valid CADfix client or contact CADfix to discuss your license options. 

 

 

 

Invalid return data (error:-12,16) 

 

 

The only case where I have seen this error had all license FEATUREs expired. - This notification is shown 

in the license log file. 

No other user activity was shown in the license log. 
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Cannot connect to server system (error:-15,xxx) 

 

 

CADfix has details to connect to the license server (either from a local license file or CADFIX_KEY), but it 

is not getting a response. 

It may be that: 

• The wrong license server details are being used in CADFIX_KEY, or an old license file is in the \lic 

folder. 

• The license server services may not be running. 

• Communications to the server may be blocked by a firewall. 

 

Verify details of point 2 and 3 in the license server’s log file. 

 

 

 

 

License server does not support this version of this feature. (error:-25,xxx) 

 
  

The user is trying start up a newer version of CADfix than is allowed by the license file.  

E.g. the license is for 12.0, and they are trying to start 13.0. 
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User/host not on INCLUDE list for feature. (error:-39,xxx) 

 
  

An option file is in use to define a user list. The users are not found in this list because: 

• Their name has not been added to the list. 

• An error occurs in the list (e.g. too many characters in the list’s line) 

 

License server machine is down or not responding (error:-96,xxx) 

  

The CADFIX_KEY or local copy of the license file references the license server by name, but it cannot be 

contacted.  

It may be: 

• The license server is down. 

• The server may not be reachable by this name and should be replaced by another name or IP 

address. 

• Or the wrong license file is being used. 

 

The desired vendor daemon is down (error:-97,xxx) 

 

 

The vendor daemon (itiohio) is not running. This is because the daemon will not start, or communication to 

it is being blocked (possibly by a firewall). 

Check the license log file to see if it is still running.  

If the itiohio daemon is running, check that the required ports are open. See Ports and Firewall Settings.  



 

 Public  

International TechneGroup Limited Page 29 of 29 Copyright © ITI 2026 

Cannot checkout an uncounted license within a Windows Terminal 

Services… (error:-103,xxx) 

 

 

The user is accessing a CADfix client machine via Terminal Services to run CADfix. The CADfix license is 

node locked to only allows CADfix use on the client machine, not the display computer where the user is 

located. 

Either: the user must work directly on the licensed CADfix client or contact CADfix to discuss their license 

options. 

 

FlexNet Licensing Error (error:-140,148) 

 

 

The license server is using an older version of FlexNet than the version of CADfix being run. 

Upgrade the license server to match the version of CADfix being used (or later). 

 

 

Invalid licensing for this product 

 

The CADfix startup settings are wrong. - Please contact CADfix support to verify your installation. 

 

 


